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Abstract—The increasing number of missing person cases worldwide presents a significant challenge to law 

enforcement agencies and communities. TraceNet is an advanced AI-powered Missing Person Identification 

System designed to address this issue through the integration of machine learning, computer vision, and data 

analytics. The system utilizes deep learning-based facial recognition models, particularly Convolutional 

Neural Networks (CNNs), to analyze and match facial features from images and video streams against a 

centralized database of missing individuals. TraceNet supports real-time identification by processing 

surveillance footage, public camera feeds, and user-submitted images, enabling faster detection and response. 

The system is capable of handling variations in lighting conditions, facial expressions, aging, and occlusions, 

thereby improving accuracy and reliability. In addition, it incorporates geolocation tagging and alert 

mechanisms to notify authorities when potential matches are detected. To ensure ethical deployment, 

TraceNet emphasizes data privacy and security by implementing encryption, controlled access, and 

compliance with data protection standards. The platform is designed to be scalable, user-friendly, and 

accessible to authorized personnel, facilitating seamless collaboration between law enforcement agencies and 

the public. Overall, TraceNet demonstrates how artificial intelligence can be effectively leveraged to enhance 

public safety, streamline search operations, and significantly improve the chances of locating missing 

individuals in a timely manner. 

 

Index Terms—Missing Person Identification, Facial Recognition, Convolutional Neural Networks (CNN), 

Deep Learning, Computer Vision, Surveillance, Geolocation, Real-Time Detection, Data Privacy, Public 

Safety 
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I. INTRODUCTION 

Missing persons represent one of the most pressing humanitarian challenges faced by law enforcement 

agencies, social welfare organizations, and governments worldwide. Each year, hundreds of thousands of 

individuals — including children, the elderly, and victims of trafficking — are reported missing across 

different countries. Traditional methods of locating missing persons rely heavily on manual investigations, 

public notifications, and tip-based reporting systems. While these approaches have proven partially effective, 

they are inherently slow, resource-intensive, and prone to human error. The explosive growth of digital 

surveillance infrastructure, combined with advances in artificial intelligence and computer vision, now offers 

an unprecedented opportunity to transform missing person identification into a fast, reliable, and scalable 

process. 

TraceNet is an AI-powered Missing Person Identification System that leverages state-of-the-art deep learning 

techniques, real-time video analytics, and a centralized biometric database to accelerate the detection and 

recovery of missing individuals. At its core, TraceNet employs Convolutional Neural Networks (CNNs) for 

facial feature extraction and matching, enabling it to identify potential matches even under challenging real-

world conditions such as poor lighting, partial occlusions, facial aging, and varying head poses. The system 

is designed to integrate seamlessly with existing surveillance networks, public camera infrastructure, and law 

enforcement databases, making it a practical and deployable solution rather than a purely academic concept.  

Beyond facial recognition, TraceNet incorporates geolocation tagging to track where potential matches are 

detected and alert mechanisms to notify relevant authorities in near real time. The platform supports multiple 

input modalities, including uploaded photographs, live video streams, and social media imagery, providing a 

flexible and comprehensive identification pipeline. Ethical considerations are central to the system's design: 

TraceNet implements robust data encryption, role-based access controls, audit logging, and compliance with 

national and international data protection standards to ensure that its capabilities are not misused. 

This paper presents a comprehensive description of TraceNet, covering its design motivations, technical 

architecture, core modules, implementation details, and evaluation results. Section II reviews the relevant 

literature on facial recognition and missing person detection systems. Section III surveys existing systems and 

their limitations. Section IV describes the system workflow. Sections V through VII detail the proposed 

system, architecture, and modules. Sections VIII and IX cover implementation and testing. Section XIV 

concludes with future directions. 

II. LITERATURE REVIEW 

The problem of automated person identification has been studied extensively in the computer vision and 

biometrics communities since the 1970s. Turk and Pentland (1991) introduced the Eigenfaces method, which 

represented facial images in a low-dimensional subspace derived from Principal Component Analysis (PCA), 

enabling efficient similarity computation for face matching. While groundbreaking for its time, PCA-based 

approaches suffered from sensitivity to illumination changes, facial expressions, and viewpoint variations that 

are ubiquitous in real-world surveillance scenarios. 

The emergence of deep learning fundamentally transformed the field. Taigman et al. (2014) introduced 

DeepFace, a deep CNN trained on four million facial images that achieved near-human performance on the 

Labeled Faces in the Wild (LFW) benchmark. Schroff, Kalenichenko, and Philbin (2015) proposed FaceNet, 

which trained a deep network using a triplet loss function to embed facial images into a compact Euclidean 

space where distances directly correspond to face similarity. FaceNet achieved 99.63% accuracy on LFW, 

setting a new state of the art and establishing embedding-based face recognition as the dominant paradigm for 

high-accuracy identification. 

http://www.jaafr.org/
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Parkhi, Vedaldi, and Zisserman (2015) developed the VGGFace model, trained on a large-scale dataset of 2.6 

million images spanning 2,622 identities, demonstrating that very deep convolutional architectures pretrained 

on large facial datasets could be fine-tuned effectively for specific identification tasks. Deng et al. (2019) 

introduced ArcFace, which replaced the standard softmax loss with an additive angular margin penalty to 

enforce a more discriminative embedding space, achieving superior performance across multiple benchmarks. 

ArcFace and its variants have since become the standard backbone for high-security biometric identification 

applications. 

In the specific domain of missing person identification, Jain and Kumar (2012) examined the use of face 

recognition systems for law enforcement applications, identifying key challenges including low-quality probe 

images, the absence of a cooperative subject, and the significant aging gap between reference photographs 

and encounter images. Aggarwal et al. (2017) proposed age-invariant face recognition using generative 

adversarial networks to synthesize aged versions of reference photographs, reducing the aging gap for 

matching. Li et al. (2020) developed a cross-age face verification system that jointly trains a face recognition 

backbone with an age estimation branch, enabling more accurate matching across long time gaps. 

Recent work has increasingly focused on integrating multiple modalities and contextual signals beyond facial 

appearance. Khodabakhsh et al. (2021) demonstrated that combining facial, gait, and body silhouette features 

substantially improved identification accuracy in partially occluded surveillance scenarios. Wang et al. (2022) 

proposed a transformer-based multi-scale attention mechanism for person re-identification across disjoint 

camera networks, achieving state-of-the-art performance on the DukeMTMC and Market-1501 benchmarks. 

These advances form the technical foundation upon which TraceNet's multi-modal identification pipeline is 

built. 

III. EXISTING SYSTEM 

Prior to the development of AI-powered systems like TraceNet, missing person identification relied on three 

broad categories of approaches. First, manual database search methods required law enforcement personnel 

to manually compare photographs of missing individuals against witness descriptions or CCTV footage. This 

approach is extremely labour-intensive, subject to investigator fatigue, and scales poorly as the number of 

open missing person cases grows. The subjective nature of human visual matching also introduces significant 

inconsistency in identification decisions. 

Second, early biometric matching systems deployed at border crossings and secure facilities used template-

based face matching algorithms that compared geometric distances between facial landmarks such as the 

distance between eyes, nose width, and jaw contour. While faster than purely manual methods, these systems 

required high-quality, frontal, cooperative-subject photographs and performed poorly against the low-

resolution, non-cooperative imagery typical of surveillance footage. They also lacked any mechanism for 

handling the facial changes associated with aging, weight change, or deliberate disguise. 

Third, public alert dissemination systems such as AMBER Alert in the United States and similar frameworks 

in other countries represent a widely used non-technical approach. These systems broadcast descriptions and 

photographs of missing persons through television, radio, highway signs, and more recently mobile 

emergency alerts. While effective at raising public awareness, they depend entirely on human recognition and 

reporting, are limited to high-profile cases selected by investigators, and provide no systematic mechanism 

for automated cross-referencing against surveillance footage or social media imagery. 

None of the pre-TraceNet systems combined real-time deep learning facial recognition, multi-source input 

processing (surveillance cameras, social media, user uploads), age-invariant matching, geolocation tagging, 

http://www.jaafr.org/
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automated alert generation, and robust data privacy controls within a single unified platform. TraceNet 

integrates all of these capabilities, addressing the core limitations of each prior approach. 

Fig 1: Existing System — Manual Workflow: Photograph → Officer Review → Manual Database Search → 

Public Alert (no automation, no real-time matching, no geolocation) 

IV. WORKFLOW 

The complete processing pipeline of TraceNet proceeds through the following sequential stages:  

1. Case registration — authorized personnel upload reference photographs and demographic information for a 

missing individual 

2. Reference embedding generation — CNN backbone extracts and stores a facial embedding vector for each 

registered individual 

3. Input acquisition — surveillance feeds, user-submitted images, and public camera streams are ingested in real 

time 

4. Face detection — MTCNN detects and crops all faces present in each input frame 

5. Probe embedding generation — the CNN backbone extracts an embedding for each detected face crop 

6. Database matching — probe embeddings are compared against all registered reference embeddings using 

cosine similarity 

7. Threshold filtering — matches exceeding the confidence threshold are flagged as potential identifications 

8. Geolocation tagging — camera location metadata is attached to each flagged detection event 

9. Alert generation — automated notifications are dispatched to relevant law enforcement contacts 

At the matching stage, the system performs an approximate nearest-neighbour search across the registered 

embedding database using a FAISS index, enabling sub-millisecond query times even for databases 

containing millions of registered individuals. Matches above the primary threshold trigger an immediate high-

priority alert; matches in an intermediate confidence band are queued for human review by a case officer. This 

two-tier response strategy balances the need for rapid automated notification with the requirement for human 

oversight in ambiguous cases. 

Fig 2: Workflow Diagram — Reference Photo → Embedding → Database | Camera Feed → Face Detection 

→ Probe Embedding → Matching → Alert + Geolocation 

V. PROPOSED SYSTEM 

TraceNet is a fully integrated, end-to-end AI-powered missing person identification platform designed for 

deployment in collaboration with law enforcement agencies, civil authorities, and community organizations. 

The system is capable of processing multiple simultaneous video streams in real time, matching detected faces 

against a database of registered missing individuals, and generating geotagged alerts within seconds of a 

potential identification. The platform is built on a microservices architecture, enabling independent scaling of 

each component according to operational demand. 

Main Users: 

Law enforcement agencies — police departments and investigative units registering cases, reviewing alerts, and 

coordinating field responses 

Civil authorities — municipal governments and public safety departments managing surveillance infrastructure 

integration 

Social welfare organizations — NGOs and advocacy groups submitting community-sourced identification leads 

Authorized family members — relatives of missing individuals submitting photographs and monitoring case 

status through a secure portal 

http://www.jaafr.org/
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Core Functionalities: 

Real-time facial detection and recognition from multiple simultaneous surveillance streams 

Age-invariant and occlusion-robust face matching using ArcFace CNN embeddings 

Centralized missing person database with secure registration, update, and search capabilities 

Automated geolocation tagging of detection events with camera metadata 

Multi-tier alert system with configurable priority levels and notification channels 

Role-based access control and end-to-end encryption for all sensitive data 

Audit logging and compliance reporting for data protection regulatory requirements 

VI. SYSTEM ARCHITECTURE 

TraceNet follows a five-layer microservices architecture comprising the Data Ingestion Layer, the Face 

Processing Layer, the Identity Matching Layer, the Alert and Geolocation Layer, and the Administration and 

Audit Layer. Each layer is deployed as an independent containerized service, enabling horizontal scaling, 

independent updates, and fault isolation. 

Components: 

Data Ingestion Layer — Accepts input from three source types: live RTSP streams from surveillance 

cameras, HTTPS uploads from authorized users via the web portal, and API submissions from integrated 

third-party systems. Video streams are decoded using FFmpeg, and individual frames are extracted at a 

configurable frame rate (default: 2 frames per second per stream). Frames are queued in a Redis message 

broker for asynchronous processing by the Face Processing Layer. 

Face Processing Layer (MTCNN + ArcFace) — Applies MTCNN multi-task cascaded face detection to 

each queued frame, returning bounding boxes and five-point facial landmarks for all detected faces. Each 

detected face is cropped, aligned using the landmark-based affine transformation, resized to 112×112 pixels, 

and passed through an ArcFace ResNet-50 backbone to produce a 512-dimensional embedding vector. GPU 

acceleration via CUDA ensures throughput of approximately 150 face embeddings per second per GPU. 

Identity Matching Layer (FAISS Index) — Maintains an in-memory FAISS flat index containing the 512-

dimensional embeddings of all registered missing individuals. Each incoming probe embedding is queried 

against the index using L2-normalized cosine similarity. Matches with a similarity score above 0.75 are 

flagged as high-confidence identifications and routed to the Alert Layer. Matches between 0.60 and 0.75 are 

queued as candidate matches for human officer review. 

Alert and Geolocation Layer — Enriches each flagged identification event with the GPS coordinates or 

street address of the originating camera, derived from a camera metadata registry maintained by the system 

administrator. High-priority alerts are dispatched via SMS, email, and in-app push notification to the assigned 

case officer and supervisor. A visual dashboard displays active alerts on a real-time map, enabling 

coordinators to dispatch field units to the detection location. 

Administration and Audit Layer — Provides a secure web administration interface for case registration, 

user management, system configuration, and compliance reporting. All database access, alert events, and user 

actions are recorded in a tamper-evident audit log stored in an append-only database. Automated compliance 

reports summarizing data access patterns can be generated on demand for regulatory review. 

Fig 3: System Architecture — Ingestion Layer → Face Processing Layer → Identity Matching Layer → Alert 

+ Geolocation Layer → Administration Layer 

VII. MODULES 

7.1. Face Detection Module (MTCNN) 

http://www.jaafr.org/
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The face detection module uses the Multi-Task Cascaded Convolutional Network (MTCNN) architecture, 

which jointly performs face detection and facial landmark localisation through a three-stage cascade of 

increasingly refined convolutional networks. The first stage (P-Net) proposes candidate face regions using a 

fully convolutional sliding window approach. The second stage (R-Net) refines bounding boxes and filters 

false positives. The third stage (O-Net) produces final bounding boxes and five facial landmark points (two 

eye centres, nose tip, and two mouth corners). Adaptive input scaling ensures reliable detection for faces 

occupying as little as 20×20 pixels in the source frame, accommodating both close-range and distant camera 

viewpoints. 

Three-stage cascade achieving 98.6% detection recall at 0.3% false positive rate on FDDB benchmark 

Facial landmark alignment reduces in-plane rotation error to below 3 degrees before embedding 

Multi-scale image pyramid enables detection of faces from 20×20 to full-frame resolution 

7.2. Facial Recognition Module (ArcFace CNN) 

The facial recognition module uses an ArcFace-trained ResNet-50 backbone to map 112×112 aligned face 

images to 512-dimensional L2-normalised embedding vectors. ArcFace training employs an additive angular 

margin penalty of m=0.5 on the target class logit within the softmax formulation, enforcing a minimum 

angular separation of 0.5 radians between embeddings of different identities. The model is pretrained on the 

MS-Celeb-1M dataset comprising 3.8 million images across 85,742 identities and fine-tuned on a law-

enforcement-provided dataset of booking photographs for improved accuracy on non-cooperative, low-quality 

probe images. 

ArcFace ResNet-50 achieves 99.41% accuracy on LFW benchmark and 91.75% on AgeDB-30 age-gap 

benchmark 

512-dimensional embeddings stored in FAISS flat index; sub-millisecond query latency for databases up to one 

million individuals 

Fine-tuned on 200,000 surveillance-condition probe images to improve robustness to compression, blur, and 

partial occlusion 

7.3. Age and Occlusion Robustness Module  

To handle the temporal gap between the reference photograph taken at the time of disappearance and the 

probe image encountered during detection, TraceNet incorporates an age simulation preprocessing step. A 

conditional GAN (cGAN) trained on the CACD (Cross-Age Celebrity Dataset) synthesizes aged versions of 

the reference photograph at five-year intervals from the registered age to the current age, producing multiple 

reference embeddings per individual. During matching, the probe embedding is compared against all aged 

variants of each registered individual, and the maximum similarity score across all age variants is used as the 

final identification confidence. 

Age simulation cGAN trained on 163,446 images from CACD spanning age range 14–62 

Aged variant embeddings precomputed and cached; no inference overhead during real-time matching 

Occlusion robustness achieved by training on synthetically occluded images with random rectangular masks 

covering 10–40% of facial area 

7.4. Geolocation and Mapping Module 

The geolocation module maintains a camera registry database mapping each camera's unique identifier to its 

GPS coordinates, address, administrative jurisdiction, and assigned case officer contacts. When a positive 

identification event is generated, the camera identifier from the source stream metadata is used to retrieve 

location information in constant time from the registry. The enriched detection event — including the probe 

image crop, confidence score, timestamp, and geographic coordinates — is published to a real-time event 

http://www.jaafr.org/
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stream consumed by the alert dashboard. A Leaflet.js-powered web map visualises all active detection events 

as colour-coded pins, with red pins indicating high-confidence identifications and orange pins indicating 

candidate matches awaiting review. 

Camera registry supports up to 50,000 registered cameras per deployment instance 

GPS coordinates accurate to 10 metres; street address derived via reverse geocoding using the OpenStreetMap 

Nominatim API 

Detection events retained in geospatial database for 90 days to support post-incident pattern analysis 

7.5. Alert and Notification Module 

The alert module implements a configurable multi-channel notification pipeline. High-confidence 

identifications (similarity ≥ 0.75) trigger immediate parallel notifications via SMS (using the Twilio API), 

email (using SendGrid), and in-app push notifications (using Firebase Cloud Messaging) to the case officer, 

their supervisor, and a configurable list of secondary contacts such as the family liaison officer. Candidate 

matches (similarity 0.60–0.75) are queued in the case management dashboard with a 30-minute response 

window before automatic escalation to supervisory review. All alert events are timestamped, logged in the 

audit database, and linked to the originating detection record for traceability. 

Median alert delivery latency of 4.2 seconds from camera frame capture to SMS receipt under standard 

operating conditions 

Configurable per-case alert recipients and escalation timelines 

False-positive suppression through temporal clustering: multiple detections of the same individual within a 5-

minute window are consolidated into a single alert event 

7.6. Data Security and Privacy Module 

All personally identifiable information stored in the TraceNet database — including reference photographs, 

embedding vectors, demographic details, and detection event records — is encrypted at rest using AES-256-

GCM with keys managed by a dedicated HashiCorp Vault instance. All inter-service communication is 

encrypted in transit using mutual TLS 1.3. Role-based access control (RBAC) enforces the principle of least 

privilege: case officers can access only their assigned cases, supervisors can access all cases within their 

jurisdiction, and system administrators have no access to case data. Biometric data is retained only for the 

duration of the active case and is permanently deleted within 30 days of case closure.  

AES-256-GCM encryption at rest; mTLS 1.3 encryption in transit for all service communication 

RBAC enforced at the API gateway layer using JWT tokens with embedded role and jurisdiction claims 

GDPR and PDPA compliance achieved through automated data retention policies and subject access request 

workflows 

VIII. IMPLEMENTATION 

8.1. Environment and Dependencies 

TraceNet is implemented in Python 3.10 and deployed as a set of Docker containers orchestrated with 

Kubernetes. Core dependencies include PyTorch 2.0.1 with CUDA 12.1 for CNN inference, the InsightFace 

library (version 0.7) for ArcFace model weights and MTCNN implementation, FAISS 1.7.4 (GPU edition) 

for embedding index operations, FFmpeg 6.0 for video stream decoding, Redis 7.0 as the inter-service 

message broker, PostgreSQL 15 for relational data storage, and PostGIS 3.3 for geospatial query support. The 

web administration interface is built with React 18 and communicates with the backend via a GraphQL API. 

All service dependencies are pinned in per-service requirements.txt files and Docker images are tagged with 

content-addressable SHA256 digests for reproducibility. 

http://www.jaafr.org/


                       © 2026 JAAFR | Volume 4, Issue 5 May 2026 | ISSN: 2984-889X | JAAFR.ORG 
 

    

JAAFR2605081 Journal of Advance and Future Research (www.jaafr.org) 723 
 

8.2. Database Design 

The central PostgreSQL database contains four primary tables: the Persons table storing demographic 

information and case metadata for each registered missing individual; the Embeddings table storing the 512-

dimensional ArcFace embedding vectors and their age-variant siblings as binary blobs; the Cameras table 

storing camera registry information including GPS coordinates, jurisdiction, and contact assignments; and the 

DetectionEvents table recording every flagged identification event with full provenance, including the probe 

image crop stored as an S3 object reference, the matched person identifier, the confidence score, the 

originating camera identifier, and the timestamp. Foreign key relationships enforce referential integrity 

between all tables, and appropriate indices ensure query performance at operational scale. 

8.3. Model Training and Fine-Tuning 

The ArcFace ResNet-50 backbone was fine-tuned on a curated dataset of 200,000 surveillance-condition 

probe images sourced from law enforcement training datasets and synthetically augmented with JPEG 

compression (quality 40–70), Gaussian blur (sigma 1–3), brightness/contrast jitter (±30%), and rectangular 

occlusion masks. Fine-tuning used the AdamW optimiser with an initial learning rate of 1e-4 and a cosine 

annealing schedule over 20 epochs. The age simulation cGAN was trained on the CACD dataset using the 

Adam optimiser with a learning rate of 2e-4 for 100 epochs on 4 NVIDIA V100 GPUs. All model checkpoints 

are versioned in an MLflow model registry and deployed via a dedicated TorchServe inference server. 

8.4. Deployment Architecture 

The production deployment uses a Kubernetes cluster with 8 GPU nodes (each equipped with 2 NVIDIA 

A100 GPUs) for the Face Processing Layer and 4 CPU nodes for all other services. The FAISS identity 

matching index is sharded across 4 in-memory Redis instances to support databases of up to 10 million 

registered individuals with sub-10-millisecond query latency. A Kong API gateway handles authentication, 

rate limiting, and TLS termination for all external traffic. Horizontal Pod Autoscaling (HPA) automatically 

scales the Face Processing service between 2 and 32 replicas based on the Redis queue depth, ensuring that 

peak-load periods — such as large public events with dense surveillance coverage — do not result in 

processing backlogs. 

IX. SYSTEM TESTING 

System testing was conducted across five phases to validate identification accuracy, pipeline throughput, 

robustness to challenging input conditions, security controls, and operational alert delivery performance.  

9.1. Unit Testing 

Each module was tested in isolation. The MTCNN detection module was evaluated on the FDDB face 

detection benchmark, achieving a true positive rate of 98.6% at a false positive rate of 0.3%. The ArcFace 

embedding module was evaluated on the LFW benchmark (99.41% accuracy at equal error rate threshold) 

and the AgeDB-30 benchmark (91.75% accuracy), confirming state-of-the-art performance on both standard 

and age-gap evaluation sets. The FAISS matching index was tested with synthetic databases of 100,000, 

500,000, and 1,000,000 embedded individuals, achieving query latencies of 0.8 ms, 2.1 ms, and 4.7 ms 

respectively — all below the 10-millisecond target. 

9.2. Integration Testing 

End-to-end pipeline correctness was validated by registering 500 individuals from a held-out evaluation set 

and submitting 2,500 corresponding probe images (5 probes per individual) through the complete pipeline. 

TraceNet correctly returned the registered individual as the top-1 match for 2,413 of 2,500 probes (96.5% 

Rank-1 accuracy). Of the 87 unsuccessful probes, 61 were attributable to extreme head poses exceeding 45 

degrees, 18 to heavy occlusions covering more than 50% of facial area, and 8 to image resolution below 32×32 

pixels — all edge cases outside the system's design operating envelope. 

http://www.jaafr.org/
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9.3. Robustness Testing 

The pipeline was tested against five categories of degraded input conditions: JPEG compression at quality 

factors 90, 70, 50, and 30; Gaussian noise at sigma 5, 10, 20, and 40; uniform illumination reduction to 50%, 

30%, and 10% of standard; head pose rotation of 15, 30, and 45 degrees in yaw; and rectangular occlusions 

covering 10%, 25%, and 40% of facial area. Rank-1 accuracy remained above 94% for JPEG quality factors 

as low as 50 and illumination reductions to 30% of standard. Accuracy degraded to 81.2% at 45-degree yaw 

and 78.4% at 40% occlusion, identifying these as the primary failure modes for future architectural 

improvements. 

Component Existing Approach TraceNet System 

Face Detection Haar Cascades / Dlib MTCNN Multi-Stage Cascade 

Recognition Model PCA / Geometric Features ArcFace ResNet-50 

Age Handling None cGAN Age Simulation 

Input Sources Manual Upload Only Surveillance + Upload + API 

Alert Mechanism Manual Notification Automated Multi-Channel 

Geolocation None GPS-Tagged Detection Events 

Data Security Basic Password Access AES-256 + RBAC + mTLS 

Table 1: Comparison of Existing Approaches vs TraceNet System 

9.4. Ablation Study 

A systematic ablation study evaluated the contribution of each key component to the overall Rank-1 

identification accuracy on the 2,500-probe evaluation set. Replacing ArcFace with a standard softmax-trained 

ResNet-50 reduced accuracy from 96.5% to 91.3%, confirming the value of the angular margin loss. Disabling 

the age simulation module reduced accuracy on probes with an age gap exceeding 10 years from 94.1% to 

83.7%, demonstrating the significant impact of age-invariant matching for long-duration missing person 

cases. Disabling the occlusion-augmented fine-tuning reduced accuracy on occluded probes from 78.4% to 

64.9%. Each component contributes independently and additively to the overall system performance.  

9.5. Security and Privacy Testing 

Penetration testing was conducted by an independent security assessment team using OWASP WSTG 

methodology. No critical or high-severity vulnerabilities were identified in the tested API endpoints, 

authentication flows, or data access controls. Role-based access control was verified by confirming that API 

requests authenticated with case-officer-level tokens were rejected for all supervisor-level and administrator-

level endpoints. Encryption at rest was verified by inspecting the raw PostgreSQL data files and S3 object 

storage, confirming that all sensitive fields were stored in AES-256-GCM ciphertext. A simulated data breach 

scenario confirmed that stolen ciphertext was computationally intractable to decrypt without access to the 

Vault-managed key material. 

X. SECURITY AND PRIVACY MECHANISMS 

TraceNet's security architecture is designed around a defence-in-depth strategy in which multiple independent 

security controls protect sensitive biometric and case data at every layer of the system. At the data layer, all 

personally identifiable information is encrypted at rest using AES-256-GCM, with encryption keys stored in 

a dedicated HashiCorp Vault instance that enforces key rotation every 90 days and maintains a complete key 

access audit log. At the network layer, all inter-service communication uses mutual TLS 1.3 with certificate 

pinning, preventing man-in-the-middle attacks within the cluster. External API access is protected by the 

http://www.jaafr.org/
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Kong API gateway, which enforces JWT-based authentication, rate limiting of 100 requests per minute per 

client, and IP allowlist filtering for administrative endpoints. 

At the application layer, the RBAC system enforces the principle of least privilege through a hierarchical 

permission model with four roles: Viewer (read-only case status access), Officer (case registration, alert 

review, and probe submission), Supervisor (jurisdiction-wide case and user management), and Administrator 

(system configuration only, no case data access). All user actions — including case registrations, database 

queries, alert acknowledgements, and configuration changes — are recorded in a tamper-evident audit log 

that cannot be modified or deleted by any user role, including administrators. The audit log is replicated in 

real time to an offsite immutable storage system to ensure availability for regulatory review even in the event 

of a primary system compromise. 

XI. SYSTEM FEATURES 

TraceNet provides a comprehensive feature set that directly addresses every limitation identified in existing 

missing person identification approaches. The ArcFace-based facial recognition pipeline provides 

identification accuracy approaching the state of the art across standard benchmarks while remaining robust to 

the challenging input conditions typical of real-world surveillance footage. The MTCNN multi-scale face 

detection module handles faces across a wide range of sizes, orientations, and distances from the camera, 

enabling reliable detection from both indoor and outdoor surveillance infrastructure. 

The age simulation module using a conditional GAN addresses one of the most persistent challenges in long-

duration missing person cases, where the time elapsed between the reference photograph and the potential 

encounter image may span years or decades. The multi-source input pipeline — supporting simultaneous 

ingestion from dozens of surveillance streams, public APIs, and community-submitted images — provides a 

comprehensive coverage net that manual investigation methods cannot replicate. The geolocation tagging and 

real-time alert system enable law enforcement to dispatch field units to the detection location within minutes 

of a positive identification, dramatically reducing the time between detection and physical response.  

The role-based access control system and end-to-end encryption framework ensure that the system's powerful 

identification capabilities are not misused, protecting the privacy and dignity of registered individuals and 

conforming to applicable data protection legislation. The Kubernetes-based microservices deployment 

ensures that the system can scale horizontally to accommodate large-scale deployments spanning multiple 

cities or regions without architectural modification. 

XII. RESULTS AND DISCUSSION 

TraceNet was evaluated on a 2,500-probe held-out test set constructed from five probe images per registered 

individual, spanning a range of input conditions including varied lighting, head poses, and image quality 

levels. The system achieved Rank-1 identification accuracy of 96.5% across all probe conditions, with 

accuracy remaining above 94% for JPEG-compressed inputs at quality factor 50 and above 90% for 

illumination conditions at 30% of standard levels. Alert delivery latency averaged 4.2 seconds from camera 

frame capture to SMS notification receipt under standard load conditions, meeting the operational requirement 

of under 10 seconds. 

Throughput testing under simulated peak load — 120 simultaneous surveillance streams each providing 2 

frames per second — demonstrated sustained processing of 240 frames per second with an average embedding 

extraction latency of 6.8 ms per face. The Kubernetes HPA controller scaled the Face Processing service from 

4 to 18 replicas within 90 seconds of load onset, confirming the system's elastic scalability. The FAISS index 

maintained sub-5-millisecond query latency for a 1-million-individual database throughout the peak load test, 

confirming readiness for large-scale national deployment. 
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Metric Result 

Rank-1 Identification Accuracy 96.5% 

LFW Benchmark Accuracy (ArcFace) 99.41% 

AgeDB-30 Benchmark Accuracy 91.75% 

Alert Delivery Latency (Median) 4.2 seconds 

Peak Throughput (Frames/sec) 240 frames/sec (18 replicas) 

FAISS Query Latency (1M individuals) 4.7 ms 

Table 2: TraceNet System Performance Results 

XIII. FEATURE ENHANCEMENTS 

While TraceNet provides a robust and operationally validated foundation for AI-powered missing person 

identification, several future enhancements are planned to improve accuracy, coverage, and usability. Multi -

modal biometric fusion, incorporating gait analysis from video sequences and body silhouette matching 

alongside facial recognition, would enable identification of individuals whose faces are obscured or whose 

surveillance footage is too low-resolution for reliable facial matching. This is particularly relevant for children 

whose facial appearance changes rapidly during development. 

Integration with social media monitoring APIs would allow TraceNet to extend its detection coverage beyond 

fixed surveillance infrastructure to the vast ecosystem of publicly shared photographs and videos on social 

platforms, where missing individuals may appear in the background of unrelated content. Natural language 

processing components could extract location and contextual information from associated captions and posts, 

providing additional investigative leads. A mobile application for authorized community volunteers would 

enable crowdsourced sighting reports to be integrated directly into the TraceNet alert pipeline with appropriate 

privacy controls. 

Federated learning mechanisms that enable multiple law enforcement agencies to collaboratively improve the 

shared identification model without sharing raw biometric data across jurisdictional boundaries would 

strengthen the system's accuracy across diverse demographic groups and geographies while preserving data 

sovereignty. Lightweight model distillation for edge deployment on camera hardware would reduce the 

latency of the complete identification pipeline by eliminating the network round-trip between camera and 

central processing server, enabling identification decisions to be made at the point of capture. 

XIV. CONCLUSION 

TraceNet demonstrates how artificial intelligence can be effectively and responsibly leveraged to address the 

critical public safety challenge of missing person identification. By integrating ArcFace deep learning facial 

recognition, MTCNN multi-scale face detection, age-invariant cGAN-based reference augmentation, FAISS-

accelerated embedding matching, real-time geolocation tagging, and automated multi-channel alert delivery 

within a secure, scalable, and privacy-preserving platform, TraceNet achieves a Rank-1 identification 

accuracy of 96.5% and an alert delivery latency of 4.2 seconds — performance levels that are entirely beyond 

the reach of manual investigation methods. 

The system's modular microservices architecture, Kubernetes-based elastic scaling, and defence-in-depth 

security framework ensure that it is ready for production deployment at both city and national scale. Ablation 

experiments confirm that every component of the proposed pipeline contributes independently to 

identification accuracy, providing a clear roadmap for continued improvement. As AI and computer vision 

technologies continue to advance, TraceNet's extensible architecture provides the foundation for incorporating 

emerging modalities such as gait recognition, social media monitoring, and federated cross-agency learning, 
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ensuring that the system remains at the forefront of the ongoing effort to locate missing individuals and reunite 

them with their families. 
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